Play Music

Entry-level music notation software

Everything you need to compose, play, and print your own sheet music!
New score setup.

A Brief Outline.

In order to get a thorough understanding of some of the main features of “Play Music” you will be instructed to perform and undo certain items while creating the example scores. This is intended to give as much insight into the workings of “Play Music” as possible. Spending an hour or two with this tutorial should leave you ready to begin working on your music. Obviously, we cannot cover everything in this manual, please visit our web site for free updates to the program and the manual or contact us at the address on the box or call us for any questions you may have. If you make a mistake during the Create Your New Score setup, don’t get frustrated, simply start over or click on new from the file section of the toolbar and you’ll start a new score. You can also access the individual functions from the top toolbar. It is important to notice your mistakes and understand the “Create Your New Score” page because this is where the outline of your score will be structured. Once you understand the functions in the “Create Your New Score” page you will easily master the program in no time. “Play Music” is a very easy to learn program and is well worth the time you will spend learning the program. If you have a problem with the program not responding to commands click on the page redraw button next to the page number box or simply hit F5 on your computer keyboard. This will fix most problems with the program not responding to your commands. It’s a good practice to perform this command before playing back your compositions.

NOTE: To better view the figures throughout this manual, simply use the magnifying tool to zoom in (they may appear unclear at 100%).

Enjoy……..

New score setup.

Create New Score

From the File menu at the top left of the toolbar click New. “Play Music” is now displaying all of the primary functions you will need to create your new score on one page. Do not click the OK button in this main window until you have your score set up exactly the way you want it. If you click the OK button by mistake simply close the page and start over. When the Create Your New Score page appears, click on the “single staff” button in the select stave section. Note (You can choose “single” – “keyboard” – “guitar tab” or “percussion” staves for your new score). For this example score we clicked on “single” staff. The word “single” will appear once in the Staves List box window. Click again on the “single” button from the select staff section. A second stave will appear in the Staves List box window. Any number or type of staves may be added in this manner. Click on any of the “single” staves in the “Staves List” window to highlight it. Click on the “delete staff” button. Each “single” stave that you have highlighted will be deleted. Add or delete the single staves until you have three “single” staves in the “Stave List” window.

“Play Music” includes percussion staves. Click on the “percussion” button in the select staves section from the same section you clicked the “single” staff. You have now added a percussion stave. Highlight percussion in the Staves List window and click on the “delete staff” button. You will notice that you deleted the percussion staff from your score, perform these same functions for all of the different types of staves to add or delete the desired type and number of staves you want for your score. “Play Music” will allow you to create a score with a maximum of twenty-four different staves. For now, we’ll work with just three until you get more comfortable with the programs functions.

![Create Your New Score](image)

Figure 1
New score setup.

Instrument names.

Double click the first “single” line in the “Staves List” window. The Instruments Name Management sub-window will appear. In the Instrument Name window, type Piano. Click the small boxes to the left of “Apply same size to all staves” so that check marks appear. Click the OK button in the Instrument Name Management sub-window. Double click the second “single” line in the “Staves List” window and type Violin in the Instrument Name window. Click the OK button in the Instrument Name Management sub-window. The Instrument Name Management sub-window also allows you to set the size of your staves. Double click on the “Piano” line to open the Instrument Name Management sub-window. Highlight the 0.250 in the “Staff Size” box and type in the number 0.500. The selected staff size will change in the score according to the number you type in the “Staff Size” box. For now we’ll use the setting of 0.250 as our staff size. Highlight the .500 in the “Staff Size” box and type in the number 0.250. The staff size will now be 0.250. Experiment with different sizes until you find the size you like and remember you can have different staff sizes for different instruments.

*You can also use the handles palette to change the size and space of the staves. We will discuss this in the Palettes section.

New score setup.


Click on the Set Systems Per Page box, type 4. In the Set Measures Per System box, type 4. The score will change as the systems and measures are increased or decreased. It’s important to remember that if you have more than six staves you will want to set the Systems Per Page to a lower number to not clutter the score. Other operations such as system connections and bar line connections can be set here as well. Hold down the shift key on your computer keyboard and click on Piano and Violin in the “Staves” window to highlight them. If you click the bracket button from the “Set Connection Types” a bracket will appear connecting the Piano and the Violin staves. If you highlight all of the instruments in the “Staves” window the bracket will appear connecting all of the highlighted staves. Click the same button again and the bracket will disappear. Many of the operations in Play Music can be undone by simply repeating the command a second time.

You may also choose from the two types of bar-lines by clicking one of the two active buttons below the word “Bar Line Types”. Click the single staff button on the left below the word “Bar line Types”. The bar line will disappear from between the staves. Click the continuous button, and the page will return to normal.
New score setup.

Margins. Page layout.

In the Page Margins section (see Figure 3) you will perform the functions to design the way your score will appear on the page. In the Page Margins section you will see four different boxes; top, left, bottom, and right. In the “top” box highlight the current number and type 1.500 in the box. This will adjust the top spacing of your score. In the “left” box, type 1.125 in the box. This will adjust the left spacing of your score. In the bottom box, type 1.000 in the box. This will adjust the bottom spacing of your score. In the “right” box, type 0.500 in the box. This will adjust the right spacing of your score. Experiment with the spacing values and find the values that best suit your taste.

New score setup.

Measure Numbers. Set Key Signature. Set Time Signature.

Measure Numbers

From the toolbar click on “Layout” (the “Layout” area is where you will find all of the functions you will need to set up the basic structure of your score outlined in the last section). Scroll down from “Layout” to the "measure" line. To the right of the measure line you will see “Add Measures”, Remove Measures” and “Measure Numbers”. This is where you can adjust the number of measures you want in your score. Simply click on the desired function and insert the number of measures for your score.

Key Signature

From the toolbar select “Layout”. Scroll down to the “Key Signature” line and click on the highlighted “Key Signature line. The modify key signature page appears and you will now be able to select the key signature for your score. You can select the number of measures you want to have a particular key signature assigned to in the “starting from measure” box and the “to measure” box. You will only be allowed to select the actual number of measures you have previously selected for your score in the “to measure” box. Now that you have selected what measures you want the desired key signature to be applied to you are ready to select a key signature from the “Select a Key” area. Click on any of the fifteen key signature displays and you will see the selected key signature in the “Selected Key” box at the bottom of the page. The “Selected Key” box will display the major key signature and the relative minor key signature. You have now selected the key signature for your score.
**Time Signature**

From the toolbar select “Layout”. Scroll down to the “Time Signature” line and click on the highlighted “Time Signature” line. To the right of the time signature line you will see “Set Time Signature” and “Time Signature Options”. Highlight the “Set Time Signature” line and click. You are now at the section where you can set the time signature for your score. Just like the key signature page you can select the number of measures you want the time signature to be applied to. Select the desired number of measures and we will be ready to select our time signature. You will see two areas displaying time signature options, the first is the “Standard Time Signatures” and you will find standard time signatures displayed for you to select. You will notice the circle to the left of “Select a standard time signature” is checked. If you want a standard time signature you must click on this circle. Below the “Standard Time Signature” section is the “Customized Time Signatures” section. Click on the circle to the left of “Customize the Time Signature” and type in your desired custom time signature in the two boxes to the right. You have now selected your Time Signature for your score and you are ready to start adding notes to your score.

Figure 6
New score setup.

Palettes.

In this section, notes will be entered with the mouse. Step and real-time entering will be discussed in a later section. On the Left hand side of the page there are eight different symbols and a green button labeled “Open” and a red button labeled “Close”. These symbols will always appear next to your score. Clicking on the green “Open” button will open and display all eight available palettes. The red “Close” button will close all of the palettes. Clicking on one symbol will open that individual palette. For example, the eighth note icon opens the notes palette. You will also notice at the bottom of the score you will see what the individual symbols contain. For example, when you place your mouse pointer over the eighth note you will see displayed (Opens the Notes Palette, which allows the user to enter notes on the score). You will notice that when you place your mouse pointer over every function in “Play Music” the display at the bottom of the score will give a brief description of the function. It is best to familiarize yourself with all of these palettes in order to memorize which icon opens which palette.

Click on the eighth note symbol and the notes palette will open. Simply click on the desired note and you will see what the value of the note is from the display at the bottom of the score. Simply click on the note desired and move your pointer into the score area and you will notice that the pointer now changes into the note or symbol you selected.

In the top toolbar you will see three buttons with an arrow, a pencil, and an eraser. By clicking on the arrow button you can move the notes or markings (markings can be dynamics, slurs, articulations etc.) on the score. For instance, if you place a note on the wrong line in the stave simple click the arrow button click and hold the pointer/arrow on the note head or marking and move the note or marking to the desired line. You can also perform this function to move notes and markings left to right or to simply place the note or marking where ever you want. Clicking on the pencil button will enable the palette again and will automatically return to the last note or marking that you used. Clicking on the erasure button will allow you to erase any note or marking on the score. Simply click the erasure button and place the erasure over the note or marking and click the note or marking will be deleted. If you make a mistake and want to undo the last function you will see two buttons with blue arrows from the tool bar. Simply click on the left button with the arrow pointing to the left and the last function will be undone. The button to the right with the arrow pointing right will redo the function.

As in most programs, Play Music allows you to cut, copy, and paste all objects. Use the arrow to highlight the first measure of your score. Press and hold the control key and click the C key; click in the second measure (if the second measure has notes already entered chose a measure that doesn’t have any notes) and press control V.

You will now have the same notes and markings from the first measure in the second measure (or whatever measure you chose). All of the functions you select in Play Music can be done in this same way; simply highlight the area you desire to edit and select the function from the toolbar and the edit will be completed.
Handles Palette
Go to the palette section on the left side of the score. Directly above the green “Open” button is “Handles Palette. Click on the “Handles Palette” and the “Handles palette will open displaying six buttons. The “Handles Palette” will allow you to perform several functions to your score. These functions are: changing slur shapes, changing tie shapes, changing bar line length, changing staves distance, changing triplet shapes, and de-activating the handles. Click on the middle left button named “Activate Bar line Handles”. Red squares will appear above all the bar lines in the score. Simply click and hold your mouse button and you can move the bar line left and right. Using this function you can create a customized score by editing the length of your staves.

Click on the middle right button named “Activate Staves Handles”. Another red square will appear above the first bar line of each stave. Click and hold the square and you can move the selected stave to any desired distance between staves. Again, this function will allow you to create a customized score. The remaining buttons will activate handles on the selected functions. For instance, locate the “Slurs and Octave Palette” on the left side of your score. Click on the “Slurs and Octave Palette” and the palette will open. Click on the top left button named “Insert Slurs”. Again your pointer will turn into a cross. Moving left to right in the distance of one measure click four times. You will see a line appear, go back to your “Open Handles Palette” and click on the top left button “Activate Slurs Handle” you will see four red squares appear on the line (this line is actually a slur). Click and hold any of the red squares and move your mouse.

You will notice that the slur is changing shape. You can shape the slur any way you want. This is an example of the ease of use and power of “Play Music”; you will notice you can easily perform these types of functions for every edit you will want.

New score setup.
Templates
Play Music includes many templates that can be accessed to make it easier to create your score. More than likely, you will modify templates that are provided. Any time you are writing or copying a piece of music, save it as a template and you will be able to use the format in future compositions. To access the Templates click on the File menu and scroll down to “Open Templates”, find the “Template” that suits your tastes and highlight the desired Template. You can choose any of the templates to create various types of compositions.

NOTE: If you find that you can’t scroll up and down using a template, make sure you have the page maximized. You can maximize your page by clicking the top middle button next to the close box at the top right of your page.
New score setup.

Inserting Text, Lyrics, Chord Grid

**Text**
Click on “Insert” from the toolbar. You will see text, lyrics, and chord grids displayed. Pull the pointer down to highlight “Text” and click. The “Text Insertion” page will now appear. Type “I Want Play Music” in the write your text box and click OK. Your arrow will now turn into a cross, select the space on the score where you want the “I Want Play Music” text to appear and click. Click on the arrow button from the toolbar next to the pencil button and place the arrow over the text “I Want Play Music” and hold the mouse button and move the mouse. You can move the text anywhere you chose on the score.

**Lyrics**
You will perform the same functions to insert lyrics as you did with inserting text with the exception that you must have notes to correspond with the lyrics. If you attempt to add lyrics to a measure that does not have notes it will not work. Click on “Insert” from the toolbar and highlight “Lyrics”. The “Lyrics Insertion” page is now open. Type “I want play music” in the text box and click OK. The arrow will again turn into a cross. Click on the first note where you want the “I” from “I want play music” and the lyrics will line up with the notes. If you move a note in the score and have a lyric assigned to the note, the lyric will move with the note.

**Chord Grids**
Click on “Insert” from the toolbar and highlight “Chord Grid”. The “Guitar Chord Grid” page is now open. You can select major or minor chords and also select the chord tonality (C, C#, D, D#, etc.) Scroll from the select chord box until you find the desired chord and highlight the desired chord. Click OK and select where you want to place the chord on the score. Perform the same functions as the “Insert Text” and the “Insert Lyrics” to move the chord grid in the score.

**Guitar Tablature**
Play Music also allows you to create guitar tablature. From the Create your new score page click on the Guitar Tab button and you will see the Guitar Tab stave displayed in the Stave List box. To activate the Guitar Tablature palette simply click on the pencil button from the toolbar next to the eraser button. When you move the mouse onto the Guitar Tab stave it will appear as a note. Simply click and hold down your mouse button on the staff or “string” line that you want to insert the fret number to and while holding the mouse button move your mouse front and back and you will see the numbers scroll up and down. When you see the desired fret number release your mouse button and that fret number will appear on the “string” line. To move the numbers on the “string” line simply click on the arrow button next to the pencil button and you can perform all of the editing functions you would normally perform.
New score setup.

Beaming. Spacing.

From the toolbar click on Notes, move the arrow down to beaming. Move the arrow to “Beaming Options” and click. The Beaming Options page is now displayed. Play Music allows you to select how the notes will be beamed or grouped together. Select the desired grouping and click OK. From the toolbar click on Notes, move the arrow down to Safe Spacing. Click on Notes again from the toolbar, make sure there is a check to the left of Safe Spacing, if there I not a check to the left of Safe Spacing move your arrow down and highlight the Safe Spacing line. Check again by clicking on Notes from the toolbar and see if there is a check to the left of Safe Spacing. Safe Spacing will ensure your notes are properly spaced, if you want to change the note spacing simply click on the arrow button next to the pencil button from the toolbar and place your arrow directly over the note head and hold your mouse button while you move the note left to right or up and down the staff.

New score setup.

Dynamics. Articulations.

Follow these basic functions to insert dynamic, articulation and phrasing marks. From the Palette section on the left of the score select the Open Dynamics Palette located directly below the Open Notes Palette. In this Palette you will find all of your Dynamic markings. Simply click on one of the markings and click on the desired area of the score. To move the marking simply click on the arrow button and click and hold again on the marking and move the marking to the desired location. Click on the bottom right button Inserting Crescendos – Diminuendos. Click and hold your mouse on the score and drag your mouse left to right for Crescendos and right to left for Diminuendos. While you drag your mouse from left to right (Crescendo) slowly move the mouse up and you will notice the marking split into the Crescendo marking. Repeat the same functions moving right to left to create a Diminuendo marking. It is also important to note that the Crescendo-Diminuendo markings can be dragged as long as you desire. In short, you can drag the markings from the first measure to the last measure in your score if you desire.

From the Palette section select the Open Articulation Palette. In this Palette you will find all of your Articulation markings. It is important to remember that the Articulation Markings can only be inputted to the score by selecting the marking and clicking on the desired note head. This will take some practice to get used to where to place the marking to get it to appear on the score. Don’t get frustrated if it doesn’t appear from your first attempt; move the mouse slowly clicking and you will find the spot to add the marking.
New Score Setup.

Inserting Notes.

From the Palette section click on the Open Notes Button. In this Palette you will find all of the note buttons you will need to compose your score. You will also find markings such as sharps and flats in this Palette. Click on any desired note and move your mouse onto the staff. You will notice that the mouse pointer will change into the note or marking you selected. Click on the desire staff line and you will hear the note you selected. If you want to change the note you entered and hear what the value of the new note will be you can audition the new note by performing the following functions. Click on the arrow cursor button and move your mouse pointer over the desired note you want to change. Click and hold your mouse button, you will hear the original note you selected sound and if you scroll your mouse up or down you will hear the notes in the staff. Simply release the button of your mouse when you find the desired note. This is also a great function for entering chords; you can actually hear the intervals as you input the chords notes.

New Score Setup.

Saving your score.

To save your score, select “Save As” from the File Menu. Title the file and place it in your music folder. At this point you can also save it as a song template for the next time you are working on this type of file. Click OK to save and return to your score page.

Special note to educators.

Lessons and exercises.

Play Music is a wonderful tool for educators and students. Often teachers would like to create lesson plans for note, key signature, time signature and clef recognition. Here are some suggestions for setting up templates for lesson plans.

From the File Menu, select New. In the “Create Your New Score” window select Single from the “Choose Staves” box. Select 1 system per page and 1 measure per system. Click OK. From the Notes menu, click on the “Safe Spacing” line so that no check mark appears in the box to the left. This allows you to place as many notes in the measure as you would like and any type of notes you chose to select. This will give you a template for exercises. Notes can be placed anywhere on the staff, clef signs and key signatures can be changed, and text can be added anywhere on the page.

Play Music offers 3 additional note-head symbols for percussion notation. Once you have entered the notes on the percussion staff, highlight them by selecting the arrow tool, holding down the left mouse button and dragging the cursor over the notes you wish to change. A black rectangle will appear around them. From the Notes Menu, select Other Options, move the cursor to the right and release the mouse button on Note-Beam-Accidental Options. Select one of the 3 note head options and click OK.
MIDI recording.

Setup.

This section of the tutorial covers recording with a MIDI keyboard or any MIDI instrument. To record with MIDI, you must have a MIDI interface connected to your computer and a MIDI keyboard or any MIDI instrument connected to the interface. A detailed explanation of how to setup your keyboard or MIDI device should be included in the owner’s manual from the keyboard manufacturer. Make sure you have successfully connected your keyboard to your computer and your sound card is functioning properly.

From the toolbar click on Playback and scroll down to Midi Input Settings. You will now see the MIDI Input Settings screen. This screen is where you will setup how you want to record your score using Play Music. In the Midi Input Settings General Settings section you will see “Click in this box to select a port for MIDI Input” and below this you will see “Click here to set!!” click on this box and you will be in the MIDI Input port settings screen. Simply select from the list of input devices you have installed on your computer and highlight that device and click OK.

The device you selected will be the device Play Music will recognize as your input device. If you change your input device you will need to come back to this screen and select the new input device.

Real time entry means you will record what you play as you are playing it. Step time recording means you will enter notes using your keyboard without worrying about playing the notes in time. If you are using your mouse as your input device you will be recording in Step time. In the box to the right of Select a Channel for MIDI Input type in the number 1. Check to make sure that your keyboard is transmitting on MIDI Channel 1; if it is transmitting on a different MIDI Channel enter that Channel number in this box. If the Channel your keyboard is transmitting on doesn’t match the Channel number in this box Play Music will not be able to detect the information from your keyboard. The next section is the Set Quantization Level area. This determines the how accurate Play Music will recognize your playing. For Real time entry it is recommended to use a higher value of Quantizing. Select the setting of 64 for the value of Quantizing and check the box Detect Triplets. Check the box to the right of Activate Metronome Click when recording in Real time. To change the Metronome speed click on the Playback line from the toolbar and scroll down to Playback Options. Highlight the Metronome Mark line and the Metronome Settings screen will open. Enter the desired value in the Set Metronome box. You can also select how the Metronome marking will appear on your score from the Metronome Mark Option line below the Metronome Mark line.

MIDI recording.

Real time.

Remember, Real time entry means you will record what you play as you are playing it. As mentioned above, it’s a good idea to use the metronome click when you record in Real time to ensure you’re playing in time. To record using the Real time option make sure you check the box to the left of Activate RPE in the MIDI Input Settings screen.
MIDI recording.

Step time.

Step time recording means you will enter notes using your keyboard without worrying about playing the notes in time. If you are using your mouse as your input device you will be recording in Step time. To record using the Step time option make sure you check the box to the left of Activate SSE in the MIDI Input Settings screen.

MIDI recording.

Voices.

Play Music allows you to have 8 separate voices per stave and a total of 24 staves per score. This means you can create a composition with 24 different instruments with each instrument playing 8 different notes at a time. In this section we will discuss how you can select different instrument voices for each individual stave of your score. From the toolbar click on the Playback line and scroll down to the Mixer line. You will now see the Mixer screen open.

This is where you will select all of the functions to change the instrument voice as well as adjusting the volume of each individual stave. When you have selected the Instrument name for each stave in the Create Your Score screen it will automatically show up in the Instrument box of the Mixer. To select a voice for your instrument simply click in the Program box to the right of the Instrument box. You will now see the Program Change screen open.
MIDI recording.
Voices. (continued)

You can select any instrument voice for each individual stave by simply clicking on the desired instrument and then click OK. This will bring you back to the Mixer screen and you will see the selected instrument displayed in the Program box. If you want to change the instrument for a desired stave simply click on the Program box again and choose a different instrument. If stave 1 is a Piano it makes sense to select a Piano sound from the Program Change screen. The next box to the right is the individual voice per stave box. Play Music allows 8 different voices per stave so you can have a different instrument for each of the 8 voices per stave. The next box to the right is the Channel section, which is also the MIDI Channel section. It is important to note that each individual voice should be set on a different MIDI Channel. An example of this would be if you have a Piano voice in the first stave and a cello in the second stave and a violin in the third stave. For the first stave (Piano) select Channel 1. For the second stave (Cello) select Channel 2. For the third stave (Violin) select Channel 3 and so on. This will allow each stave to transmit a different channel for each voice to the sound card or to an external sound module such as a keyboard. The next box to the right is the MIDI Output port, which we will discuss in the next section. The next box is the Transposition box which allows you to transpose the pitch of each voice up or down. The next box is the Volume slider where you can adjust the volume of each voice. The next box is the Solo function, which allows you to hear only the stave selected during playback even if there are 23 other staves in your score. The last box is the On box. Make sure the green dot is in this box or you will not hear that individual stave during playback.

MIDI Output Port Settings
In this section we will discuss the Midi Output Port Settings or the Device settings.

Click on the Port box in the Mixer screen. The Midi Output Port Settings screen allows you to select what device you want to use to playback your score. You can use your computer sound card or an external sound module such as a keyboard. Simply click on the device you want to use to play back your sounds and check the Apply to all staves and voices box and that is what device will be used to playback your score.

Figure 19
Beyond the basics.

Hopefully you have spent the time to complete this tutorial. The intent has been to give you an overview of the basic features of Play Music. Play Music is a powerful tool. You can spend a lot of time learning its possibilities. It is also very intuitive. For many people, the information contained in this tutorial will allow them to do everything they wish to do. Below is a list of functions contained in “Play Music” and the description of the functions.

The Toolbar

The toolbar allows you quick access to the most used functions of the program. It is comprised of a group of popup menus and boxes for the selection of voices, zoom, tools (arrow, pencil and eraser), etc. Each box displays an icon which represents a tool. To select a tool, click its icon.

The toolbar contains the following items:

The Zoom Menu

With the Zoom menu, you can set the zoom factor you want for the document. You have a choice between these possibilities: 100%, 400%, Fit Page and Fit Width (100% being the unchanged page dimension).

The Arrow Tool

With the arrow tool, you can edit all movable items directly on the score. When you click the box, the arrow cursor appears. With it, you can move notes, symbols, and beams, select a region in the score, etc.

The Pencil Tool

The pencil tool allows you to write on the document. When you select a symbol or a note from a palette, the pencil tool is automatically activated. The cursor, in the case of symbols, changes into a +, and in the case of notes, it changes into a note of the selected value.

The Eraser Tool

You can cancel items directly on the score with the eraser tool.

The Function Boxes

Clicking on the eight Function Boxes, you can apply the following functions:
Redo (Edit menu), Cut (Edit menu), Copy (Edit menu), Auto center Staves (Score menu), Tie Notes (Note menu), Tuplets (Note menu), Beam Selection (Note menu), Hide Control Points (Tools menu).

Save

The small yellow icon with the floppy disc symbol corresponds to the Save command.

Redraw

Clicking on the small painter icon will redraw the entire score.

The Voice Menu

With the Voice menu you can select the current voice. Once you have selected the current voice, all notes in other non-selected voices will appear in gray.
The first item (All) in the Voice menu reactivates and displays, in black, all present voices.
**Back to Score**
The Back to Score box allows you to return to the score.

**Mixer**
The Mixer box opens the Mixer window and allows you to change the midi channel, program changes, and change the instrument name for individual staves.

**Play**
With the Play box, you can activate a playback of the score.

**Counter Display**
This box activates the palette with the measure numbers, the beat, and the duration in hours-minutes-seconds during the performance of the score.

**Page Menu**
With this pop up menu, you can move between the various pages of the score. It is equivalent to the Go to Page function in the Tools menu.

**Go to Page**
This icon opens up the Go to Page window and displays the page number setting. This command is equivalent to the Go to Page function in the Tools menu.

---

**This section briefly illustrates how to insert the most common items into the score.**

- **Pages:** found in the Add Pages dialog window.
- **Staves:** found in the Add Staves dialog window.
- **Measures:** found in the Add Measures dialog window.
- **Notes:** use the Note palette.
- **Beams:** select a region and use the Beam Selection function (or Beam on Beat).
- **Tuplets:** select a region (group of notes) and use the Tuplet dialog window.
- **Ties:** select a region (two or more notes of same pitch) and use the Tie Notes function.
- **Slurs:** use the Symbols 2 palette (box 2) and click corresponding to four points of the curve (the slur will appear at the fourth click).
  - Various symbols attached to the notes: (e.g. Bartók pizzicato, articulations, down - or upstroke, sharp, flat, natural etc.) Use the Notes, Symbols 1, Symbols 2, Symbols 3, and Articulation palettes
  - Various symbols independent of notes: (e.g. dynamics, octave symbols, crescendos, diminuendos, pedal, trills etc) use the Dynamics, Symbols 1, Symbols 2, and Symbols 3 palettes.
- **Clefs:** use the Clefs palette.
- **Lyrics:** use the Text palette and the Lyric box, and click on the interested note head.
- **Texts:** use the Text palette and the Text box, and click on the score.
- **Frets:** use the Text Palette and the Frets box, and click on the score.
- **Tempo:** found in the Tempo dialog window.
- **Time signature:** found in the Time Signature dialog window.
- **Instrument names:** found in the Staff Settings dialog window; double-click on the interested staff in the staff list.
- **Measure Numbers:** found in the Measure Numbers window.
This section briefly illustrates how to cancel the most common items in the score.

**Pages:** found in the Remove Pages window.

**Staves:** found in the Remove Staves window.

**Measures:** found in the Remove Measures window.

**Notes:** use the eraser tool, or select note + backspace key.

**Beams:** highlight the area and go to the Beaming Options section.

**Tuplets:** reinsert the tuplet on the same notes, or select one or more control points and press the backspace key.

**Ties:** reinsert the tie on the same notes.

**Slurs:** use the eraser tool at the beginning of the slur or select one or more control points and press the backspace key.

Various symbols attached to the notes (e.g. pizzicato, articulations, down and upstrokes, sharps, flats, naturals, etc.): reattach the symbol to the same note or notes or use the eraser tool.

Various symbols independent of the notes (e.g. dynamics, octave symbols, crescendos and diminuendos, pedal, trills, etc.): use the eraser tool or select the item and press the backspace key.

**Clefs:** With the eraser tool or highlight the area and press the delete key (or also reinserting the new clef on the existing clef)

**Lyrics:** Only with the eraser tool.

**Texts:** With the eraser tool or highlight the area and press the delete key.
Play Music allows you to select some of the main functions in the program from the computer keyboard; some keys affect settings in dialog windows directly.

**Arrow**
You can select the arrow tool with the 'a' key on the keyboard.

**Pencil**
You can select the pencil tool with the 'p' key on the keyboard.

**Eraser**
You can select the eraser tool with the 'e' key on the keyboard.

**OK**
You can select OK in any window with the 'return' and 'enter' keys on the keyboard.

**The Cancel Button**
You can select 'cancel' in any window with the 'esc' key on the keyboard.

**Tab**
The 'tab' button allows you to jump to the next box in all dialog windows with parameter boxes.

**Sharp**
You can select the Sharp box (Note palette) with the 's' key on the keyboard.

**Flat**
You can select the Flat box (Note palette) with the 'f' key on the keyboard.

**Natural**
You can select the Natural box (Note palette) with the 'n' key on the keyboard.

**Play/Stop**
You can start or stop the MIDI performance by clicking the space key on the keyboard.

**Durations**
You can insert the selected duration by clicking the corresponding value on the numeric keyboard.

**Zoom**
You can select rests by clicking the 'r' key on the keyboard.

You can enlarge or reduce the zoom factor by clicking the keys ctrl + and ctrl - (Win.)